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Introduction

This Operation and Maintenance Manual describe configuration
and operation of system Active Track EBS.

In case of any doubt please contact us via our Website
http://www.ebs.pl/, email support@ebs.pl, 
or phone (+48) 22 812 05 05.

We hope you enjoy working with our devices.
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DECLARATION OF CONFORMITY
We, EBS Sp. z o.o. declare under our sole responsibility that the product
Active Track is in conformity with Directive 1999/5/EC of the European
Parliament and of the Council of 9 March 1999.
A copy of the Declaration of Conformity can be found from
http://www.ebs.pl/certyfikaty/

The content of this document is presented “as is.” No guarantees are provided, either
stated or suspected, including but not limited to this any suspected guarantees of trade
usability and any specified usefulness, unless these are required by law regulations. The
Manufacturer reserves the right to introduce changes into this document and to
withdraw it at any time without notice.  

The Manufacturer’s policy is continual development therefore reserves the right to
introduce any modifications to The Product and its functions described in The Manual
without prior notice. 

Availability of particular functions will depend on software version. For more information
turn to your nearest Dealer. 

Under no circumstances is The Manufacturer liable for any data or profit loss or for any
particular, accidental, resultant and indirect damage caused in any way. 

This device complies with Part 15 of the FCC rules. Operation is subject to the following
two conditions: (1) This device may not cause harmful interface, and (2) This device
must accept any interference that may cause undesired operation.

The crossed-out wheeled bin means that within the European Union the
product must be taken to separate collection at the product end-of life. This
applies to your device but also to any enhancements marked with this
symbol. Do not dispose of these products as unsorted municipal waste.
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1 FOR YOUR OWN SAFETY

Study the advice below carefully. Disregarding may be dangerous or illegal.
More information is provided in following parts of this Manual.

Do not switch on the device where use is forbidden, as it may cause radio
interference or other danger. 

SAFETY ON THE ROAD IS OF THE UTMOST IMPORTANCE
Do not use the device while driving a vehicle. 

RADIO INTERFERENCE
The  device  is  sensitive  to  radio  interference  that  can  influence  quality  of
connection. 

DO NOT USE THE DEVICE WITHIN HOSPITAL AREA
Follow  rules  and  regulations.  Do  not  switch  on  the  device  where  near  to
medical equipment.

DO NOT USE THE DEVICE WHILE FILLING UP A CAR
Do  not  use  the  device  either  at  petrol  stations  or  petrol  and  chemical
depots. 

SWITCH OFF THE DEVICE IN EXPLOSION AREA
Do not use the device where explosives are blasted off. Pay attention to all
limits and follow rules and regulations.

USE THE DEVICE CAREFULLY
While talking, do not hold the device too close to your ear. Avoid touching
antenna area. 

USE PROFESSIONALS
Get qualified service install and repair the device or its parts. 

BATTERIES AND ACCESSORIES
Use batteries and accessories approved by The Manufacturer only. Do not
connect chargers not compatible with the device. 
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WATER AND DUST RESISTANCE
The device is  dustproof  and waterproof  according.  It  is  yet recommended
to keep it safe from excessive dust and humidity. 

VOICE COMMUNICATION
The device operates within: 900 MHz, 1800 MHz, 850 MHz and 1900 MHz
networks.  Availability  of  those  transmission  bands  depends  on  GSM
provider network. Incoming voice connection is received automatically with
no need of pick-up and is finished when caller disconnects. 
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2 All about accessories

Before using charger, make sure it is original charger ATRACK-C – the only
model the device may be charged with.

Note: 
Use  only  the  batteries,  charger  and  other  accessories  approved  by  The

Manufacturer to work solely with this model of the device.  
Using  unauthorized  appliances  voids  guarantee  for  the  device  and  may  be

dangerous  to  user.  Turn  to  your  nearest  Dealer  to  learn  more  about  approved
accessories.  

3 Device versions

Active Track is manufactured in three versions. Available functions related to RFID
and GPS depends on the model.

Active Track

MODEL AT-G AT-R AT-GR

GSM/GPRS module · · ·
GPS module · - ·

RFID - · ·
· built-in

- lack

4 General information

PIN code

Before  first  use  make  sure  the  device  is  properly  configured.  For  more
information  go to  Configuration .  Before  first  use  get  your  SIM card  ready:  either
set  PIN  serial  code  of  the  device  or  cancel  PIN  code  request  using  mobile  phone.
Before  inserting,  make  sure  PIN  card  has  got  PIN  code  set  on  “1111”  because
originally the device has got PIN code set on “1111”. 

21
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Note: 
Once  powered,  the  device  verifies  PIN  code.  PIN  code  is  originally  set  on

“1111”.  If  your  SIM  card  number  is  different  than  “1111”,  the  card  will  be
automatically  blocked.  Unblocking  will  be  then  possible  only  by  inserting  PUK  code
using mobile phone. 
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5 Transmission safety

Data coding

Safety of data sent from the device to server is guaranteed with the very safe
and strong AES  algorithm (Advanced Encryption System).  Transmission  is  based on
the  GSM  provider  network,  therefore  the  device  uses  all  protections  offered  by
provider  to  standard  mobile  phones.  Turn  to  your  provider  for  private  APN,  if  you
want to increase system safety. 

6 Functions review

GPS module

Active Track is equipped with GPS receiver u-blox MAX 6, which allows to
specify the exact position of the device anywhere in the world.

RFID transponders reader

Depending  on  device  model,  have  built-in  RFID  transponders  reader  located
inside the device cover.

For more information, go to RFID transponder read-out .

Controlling buttons

The  device  has  got  four  controlling  buttons:  „Checkpoint”,  „Panic”,  „Call  to
me/Emergency” and „GPS”. 
For more information, go to Operation rules .

Work mode indicator

The device indicates work mode by highlighting buttons with LED diodes.
For more information, go to Indicating work mode .

70

64

69
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Loudspeaker and microphone

The device may be used as a mobile phone. The incoming calls can be limited
to  a  user-defined  phone  number  list  (see  chapter  Phone  numbers... )  and
outgoing  calls  can  be  allowed  only  to  a  predefined  number  (see  Phone
numbers ). You will find more detailed information on receiving and making
calls  with  the  device  in  points  Voice  connection  (incoming)  and  Outgoing
voice call .

Accelerometer

The device can detect its current location and its change against the axis of the
Earth’s  gravitational  field.  You  will  find  more  information  on  uses  of  the
detector  and  its  operation  in  points  Accelerometer  and  Accelerometer
operation .

Clock

The device is equipped with real time clock powered by battery.
For more information, go to Remote configuration .

Memory

The device has got memory buffered to 1000 events, stored when out of range
and sent out immediately after range is restored. 

GPRS service (General Packet Radio Service)

GPRS service allows receiving and sending data through GSM network basing
on IP (Internet Protocol).  It is  data medium which enables wireless access to
Internet.  It  is  possible  to  send SMS text  messages  simultaneously  with  GPRS
transmission. 

Before using GPRS technology

For more information, availability and GPRS service booking conditions turn to
your GSM provider or service distributor. 

50

52

65

66

14

67
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GPRS service charges

For more information turn to your GSM provider or service distributor.
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7 A few words about the device

Functional elements

1. GPS button

Sends  emergency  SMS  with  optional  location.  This
button  is  additionally  highlighted  in  green,  showing
GPS status.

2. Checkpoint  button  (optional  Read-out
button)

Sends  checkpoint  event  to  server.  In  device  version
with  built  in  RFID  transponders  reader  it  activates
RFID circuit transponders for 15 seconds. This button
is  additionally  highlighted  in  yellow,  showing  GSM
status.

 

3. Call to me button
Sends “Call  to me” report to server or  makes a voice
call  to  defined  phone  number.  This  button  is
additionally  highlighted  in  blue,  showing  charging
status.

4. Panic button

Sends “Panic” report to server. 

This button is additionally highlighted in red. 

5.  LED indicator

Shows proper charger status.

6. Loudspeaker
For  voice  communication  with  user  or  generation  of
acoustic signals.     

7. Battery lid
Closed with three bolts.
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8. Microphone

For voice communication with user.  

   

9. Charging connectors
For charging battery.

10. Charger connector

Micro USB connector for power supply unit.

8 First steps

SIM card and battery installation

 All SIM cards should be kept out of reach of children.
 SIM card and its connectors may be easily damaged by scratching or folding. 
 Special attention while inserting and removing is therefore recommended. 
 Remove battery before inserting SIM card. 

Follow these instructions to remove battery:



18 Active Track (beta version)

© 2013 EBS

1. Turn the device upside down, open lid by unscrewing bolts and take it off. 

2. Open the cover on the SIM slot and insert SIM card to holder. Make sure golden
connectors are directed downwards and close cover. 
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3. Insert battery. Connect battery connector to outlet in battery cavity. The connector
shape prevents from incorrect placing of battery – in case of trouble with placing turn
battery round and try again.

4. Lay down wires and close lid by screwing bolts. 

Battery charging

Note:
Using  chargers  other  than  advised  by  The  Manufacturer  voids  guarantee  for

the  device  and  may  damage  it.  Current  voltage  source  must  be  coherent  with  that
provided on charger’s nominal plate. 

The device marked with 230V may be supplied from main socket directly.
The device can be turned off from the network by unplugging the power plug

from the wall socket. The socket must be easily accessible - not pledged.
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Battery charging is automatic and there is no risk of overcharge. Charging time
depends on battery  load.  In  case  of  fully  discharged  battery  it  should  persist  about
4,5 hours. 

When  the  device  signals  battery  low  (for  more  information,  go  to  Indicating
work mode ), start charging. Place it as shown in diagram above.

Charging  and its  completion  is  signalled  by  the  device  (for  more  information,
go to Indicating work mode )

Note:
If the device does not signal charging when in charger, make sure charger is

plugged in and the device is placed properly.  

Sleep mode

The device is able to record such events like casing opening even when main
battery is fully discharged. It is possible thanks to auxiliary battery and special sleep
mode in which device consumes very low amount of power. The device automatically
switches to sleep mode when voltage of main battery is very low.
 
Sleep mode:
 very low power consumption
 casing opening and shock events recorded only
 limited sound and visual notifications

69

69
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 no connection to monitoring station

Note:
The device goes back from sleep into work mode when main battery  voltage

level is  good enough and after pressing any of  the buttons located on the devices's
casing.

9 Configuration

After powering-up properly configured device, it automatically connects to the
receiver of monitoring system (e.g. OSM.2007). No further action required.

There are two configuration methods:
 with SMS commands, containing data required for establishing connection with the

monitoring system receiver, see chapter Remote configuration ,
 with GPRS transmitters configuration programme, establishing connection with

the device through appropriate RS232 cable or using GPRS connection, see chapter
Configuration program .

Only  the  second  method  permits  access  to  all  programmable  parameters  of  the
device. Nevertheless, in order to use a GPRS connection using this method (e.g. when
programming  cable  is  not  available)  the  device  should  first  connect  with  the
monitoring system receiver using the first method (SMS configuration).

Remote configuration

Configuration  of  Active  Track  device  consists  in  sending  SMS  message  to  the
device or using GPRS (e.g. using OSM.2007 monitoring receiver). These steps enables
connection to server and makes all device function available. 

21

27
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In  case  of  SMS  message,  the  message  consists  of  parameter  names  and  its
values.  Each  SMS  message  begins  user  defined  access  code,  which  in  a  particular
case  may  be  empty.  When  sending  more  than  one  parameter,  they  need  to  be
separated by space character.

You may configure following parameters:

SERVER=server’s_address
Specifies IP number or domain name of the computer Server Software is

installed at. Server must be connected to the Internet with static and public IP
number.

PORT=server’s_port
Enters port of server which monitors incoming data on the server. 

APN=apn
Access point to network. APN is available at your GSM Provider. 

UN=apn_user_name
APN user name. UN is available at your GSM Provider.

PW=apn_user_password
APN user password. PW is available at your GSM Provider.

Attention:  These parameters are needed to establish connection with
communication server. If receiving device is OSM.2007 (Monitoring System Receiver
made by EBS), then configuration steps of Active Track device consists in:
- send SMS message with described on the previous page parameters (SERVER,
PORT, APN, UN and PW),
- wait until device connects to the server,
- remaining parameters send over GPRS link, using Console function of OSM.2007

TPERIOD=time_in_minutes
Defines time between following tests, which are sending to server through
GPRS link. If no parameter is programmed, device will use default value - 1
minute.
If value ends with letter „s” time will be recognized in seconds. Minimal interval
between tests is 10 seconds.  

DNS1=dns1
Specifies primary DNS server address and should be defined only if is obligatory.

DNS2=dns2
 Specifies secondary DNS server address and should be defined only if is
obligatory.
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DIAL=N,Telephone_number,M
Telephone numbers which will be recognized as authorised numbers. All other
incoming calls will be automatically disconnected.  

N
Identification number of telephone number (1 … 8). User can define up to
8 telephone numbers. 

Telephone
number

Authorized telephone number (or its part – device checks sequence of
numbers in telephone number). Entering “RING” word enables receiving
all incoming calls.

M
Number of rings before answering the incoming call. Available range: 0 to
9. 0 means instantaneous answer.

EMERGENCY=Telephone_number
Emergency telephone number. Enables direct connection of device with chosen
telephone number in case of emergency. To make a call push "Call me"/"Help
me" button. Button must be hold down until two short acoustic signals from
the device.

SMS=Telephone_number
Defines telephone number for sending SMS messages. That number is used in
case of no GPRS connection. SMS message is encrypted and can be received
and decrypted by server with connected GSM modem. When no telephone
number is programmed, SMS sending option will be deactivated.

AUTH= Telephone_number
Telephone number which is allowed to send configuration SMS message to
Active Track device. Messages are sending in plain-text, without encryption.
This option limits remote access to the device (through SMS messages). When
no telephone number is programmed, SMS messages will be accepted from
any number.

Note: 
Authorization of incoming SMS message relies on comparing telephone number
of incoming message with number saved in memory of Active Track device. It
is  possible  to  save  only  part  of  telephone  number  in  device.  In  this  case  all
telephone  numbers  which  contains  saved  sequence  will  be  authorized.  For
example:  saved  sequence  "1234"  will  authorize  telephone  numbers  such  as:
600123456 or 601234567.

DT=YY/MM/DD,hh:mm
Sets date and time in the device.

TCPCONN=init,change,limit
Defines time dependencies between connections to server attempts. After first
failed                   attempt, next will occur according to these parameters:
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init – initial time value (in minutes) after which connections attempts starts
change – defines how to change time period between attempts:

geometric progression - *x.yy, where x.yy is time in minutes with
1/100min precision

arithmetic progression - +x, where x is time in minutes
limit – maximum time between attempts.

Example 1. 
TCPCONN=2,+1,5

Defines that after first failed attempt, next will occur after 2 minutes. If
second try will fail, time period will be increased by 1 minute (so next
attempt will occur after 3 minutes). Time period is limited to 5 minutes
(parameter: limit). Next attempts will occur after 5 minutes periods. If server
is disconnected, attempts to connect will look like that (P means connection
attempt, digit means time period in minutes): P, 2, P, 3, P, 4, P, 5, P, 5, P, 5,
P, ..........

Example 2. 
TCPCONN=1,*1.5,4

Defines that after first failed attempt, next will occur after 1 minute. If
second try will also fail time period will by multiplied by 1.5, and next one will
occur after 1.5 minutes. Each next time period will by multiplied by 1.5 until
reach of 4 minutes. Next attempts will occur after 4 minutes. If server is
disconnected, attempts to connect will look like that (P means connection
attempt, number means time period in minutes): P, 1, P, 1.5, P, 2.25, P,
3.38, P, 4, P, 4, P, ..........

Default value: 1,+0,1

VOLUME=a,b,c,d,e,f, g
Defines method of signaling certain events. For each event different method of
signaling can be defined. Methods are:
   0 – no acoustic signal, no vibration 
   1 – quiet acoustic signal, no vibration
   2 - loud acoustic signal, no vibration 
   4 – no acoustic signal, vibration 
   5 – quiet acoustic signal, vibration 
   6 – loud acoustic signal, vibration 
Order of events, which can be signaled with acoustic signal or vibration: 

a) Start RFID loop
b) Read RFID confirmation
c) Discharged battery warning
d) Incoming voice call 
e) SMS message received
f) EMERGENCY call started
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g) prealarm signalling (eg. ManDown)

Note: 
It  is  not  necessary  to  give  all  the  parameters,  only  the  first  X,  for  example:
VOLUME=2  sets  the  signal  only  for  start  RFID  loop,  the  other  parameters
remain unchanged. As a consequence, to set the parameter to the position of
N all  preceding parameters should also be set.  For example,  you can not set
signaling  for  "c)  Discharged  battery  warning"  without  giving  "a)  Start  RFID
loop" warning and "b) Read RFID confirmation" in correct order.

RFID=t,n
(this parameter is only for device version with built in RFID transponders
reader)
Enables several RFID tags read-out after one push of Read-out button.
Parameters of this option:
t - sets maximum time between different RFID tags read-outs,
n - maximum number of RFID tags that can be read after single push of
Read-out button (if n=0 then there is no limit)

TCPWDT=t
  sets TCP link control, defines times between lost of TCP connection and reset

of GSM modem
t – time period [in minutes, range: 5 - 999]

  To disable this function t must be an empty string.

GSMWDT=t
Sets GSM link control, defines time between lost of GSM connection and reset
of GSM modem.
t – time period [in minutes, range: 5 - 999]

  To disable this function t must be an empty string.

GETCFG
Gets primary communication parameters of device in form: SERVER PORT APN
UN PW SMS TPERIOD

KILL 
Sending this command remotely resets the device.  

Example of SMS configuration text message (access code is 1111, skip quotes):

"1111 APN=PGuard.gprs UN=PGuard PW=PGuard_pass SERVER=gprs.com
PORT=6670 DIAL=1,600112233,0 DIAL=2,500445566,3 DIAL=3,600778899,3
SMS=500445566 DT=05/12/15,13:04 TPERIOD=5"

Example of SMS configuration text message (access code is empty, the first is a space
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character, skip quotes):

" APN=PGuard.gprs UN=PGuard PW=PGuard_pass SERVER=gprs.com PORT=6670
DIAL=1,600112233,0 DIAL=2,500445566,3 DIAL=3,600778899,3 SMS=500445566
DT=05/12/15,13:04 TPERIOD=5"

Note:
 Names of programmed parameters (e.g. SERVER) must be in upper-case

letters (see example above).
 After changing configuration of Active Track, device must be restarted with 

KILL command
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Configuration program

GPRS transmitters  configurator  may  be  downloaded  at  www.ebs.pl  (login:  ebs,
password:  ebs).  To  install  program  an  installation  wizard   shall  be  started  that
performs  installation  in  default  place  C:\Program  Files\EBS\.  During  installation
process shortcuts on screen and Windows menu are created.

If  device  is  to  be  used  for  the  first  time  it  shall  be  programmed  with  the  above
program  and  after  this  procedure  the  SIM  card  may  be  inserted  into  the  device.
Otherwise  SIM card may be blocked if  wrong PIN code is entered. Alternatively  SIM
card  may be used along with switched off PIN code. 

In case of remote programming it is necessary to insert SIM card prior to sending
configuration settings. In this situation SIM card with switched off PIN code shall be
used or before card inserting,  PIN code shall be changed to 1111 with mobile phone.

9.2.1 Computer - requirements

Minimum requirements for computer system where configuration  software is to be
installed:

Hardware:
 Processor Pentium II  400 MHz,
 64 MB RAM,
 1 GB HD.
 RS-232 serial port
 Colour monitor  (minimum 15 inch , min. 800x600 resolution),
 Keyboard    
 Mouse
 AGP3 programming adapter and LX-PROG programming cable (for local

programming)

Software:
 Operation system Windows 2000, Windows XP, Windows Vista or Windows 7.
 NET Framework 2.0 (delivered along with installation wizard of configuration). 

9.2.2 Program functions

After   installation  and  program starting  a  main  view  shall  be  displayed  on  screen.  
Thanks to this view an access to program or programmable parameters of  device is
possible.(See Programmable parameters ).
Main window of program is divided into some fields.

Main menu: at upper part of window, contains control and configuration options.
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Main menu contents: 

Main menu is available as icons on fast access bar:

9.2.2.1 File -> New

Opens new set of parameters. Editing of configuration parameters is possible. 

Select  type of device.

9.2.2.2 File -> Open

If  file  contains  saved  settings,  they  may  be  used  to  program  next  device.  Firstly  a
catalogue where file has been saved shall  be chosen and then name of file  shall  be
provided. Obtained data collection may be modified by the user. Any amendments are
effective if send to device.
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9.2.2.3 File -> Save

During programming many devices in  different configurations, it  is  not  necessary  to
have in mind each one as it may be saved on hard disc or floppy disk under any name
and  it  may  be  loaded  later  on.   This  function  save  on  disc  any  information  from
configuration  wizard  window.  After  activation  of  function  a  dialog  window  appears
with  request  to  provide  file  name.  Default  data  is  saved  with  CMI  extension
(Configuration Memory Image).

9.2.2.4 File - > Language

Allows  for  selection  of  any  available  languages  (determined  in  attached  exterior
language files).

9.2.2.5 File -> Connections

Before programming of devices, a connection type shall be defined.  It is possible to
do it with two methods:
- locally
- remotely.

9.2.2.5.1    Local connection

Local  connection  means  that  configuration  software  (namely  computer  on  which  is
installed)  is  directly  connected  to  proper  terminal  of  transmitter.  Connection  is
possible owing to special wire and through RS-232 serial port.

To  program  device  or  make  any  other  operations  (e.g.  reading  of  device  settings,
firmware amendments, etc.) it is necessary firstly  to define connection parameters.

It  is  possible  to  do  so  with  the  above  window  that  is  available  after  activation  of

connection  from Main  Menu and selection  Configuration  tab  or  after  clicking  on   
icon on fast access bar  and clicking on RS-232 tab.
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Define:
Name of connection e.g. Locally
Choose serial port e.g. COM 4

Click on [Add] button to confirm settings. Connections shall be saved (and inserted in
table).  From  this  time  on  program  shall  enable  wires  connection  with  device  and
reading, and saving  of parameters in Active Track memory will be possible.

9.2.2.5.2    Remote connection

As  provided  above  the  device  and  software  makes  for  complete  configuration  with
GPRS  link  or  CSD  channel.  This  programming  mode  requires  definition  of  linking
parameters.

9.2.2.5.2.1  GPRS linking

Activate  file  in  Main  menu  and  select   Connection  function  (or  after   clicking  on  
icon on fast access bar) and click on GPRS tab to carry out configuration of this mode.
 
 On screen the following window shall appear:

Define:

 Name of connection e.g.: Remote
 Select name of analyzer e.g.: Primary
 Enter  analyzer address e.g.: 87.128.125.8
 Enter port on which analyzer operates e.g. 7000

Click on [Add] button to confirm settings. Connections shall be saved (and inserted in
table).  From  this  time  on  program  shall  enable  remote  connection  to  device  and
reading and saving  of parameters in Active Track memory shall be possible.
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Note: 
The  following  parameters:  analyzer  name,  analyze  address,  port  relate  to

settings  of   OSM.2007  receiver  of  monitoring  system.  Remote  programming  is
available only if above mentioned device (or software) is used.

9.2.2.5.2.2  CSD linking

Activate  file  in  Main  Menu  and  select   Connection  function  (or  after   clicking  on  
icon on fast access bar) and click on GSM Modem tab to carry out configuration of this
mode. 
On screen the window shall appear where it is possible to define: 
 Name of connection e.g. Remote CSD
 Serial port where GSM modem is connected (e.g. Wavecom Fastrack)
 PIN code of SIM card installed in GSM modem e.g. 1111
 Serial  port  parameters:  amount  of  bytes/sec.  (e.g.  115200),  data  bytes  (8),

parity  (none), stop bits (1)    
 optional phone number of the SIM card installed in the modem

Click [Add] button to confirm settings and save connection (settings are inserted into
table).  Since  that  time  a  remote  connection  to  device,  reading  and  saving  of
parameters in Active Track memory is possible. 

Note: 
Remote configuration with CSD canal is possible if option of CSD data sending

has been activated both for SIM card inserted into a device and SIM card installed in
GSM modem. Beside, Active Track transmitter must enable to pick up data calls (see
GSM modems authorized phones)

Programming with CSD is  also possible  if  OSM.2007 system has  been installed,  and
minimum one GSM modem is connected. If device has been entered onto server list
(factory number and SIM card telephone number –See OSM.2007 Operation Manual)
it  is  possible  to  use  link  via  OSM.  It  is  possible  if  device  is  not  connected  to  the
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OSM.2007 via GPRS. During programming procedure (with GPRS link-  See above)  a
question  will  be  displayed  if  user  wants  to  use  a  modem  connected  to  the  server.
After confirmation procedure will follow as in case of other programming channels. 

9.2.2.6 File -> Archiving

All  configuration settings including reread from devices and saved on devices are to
be automatically saved on hard disc. If during installation on configuring tool settings
have not been changed, files will be saved as follows:
C:\Program Files\ EBS\KonfiguratorLX\configs\Active Track_80000
Catalog  Active  Track_80000 contains  all  files  in  respect  of  Active  Track  with  factory
number of 80000  programming.  The name contains date and time of operation and
its type (saving/ reading). Files have CMI extension.  

9.2.2.7 File -> Exit

Finishes program operation.

9.2.2.8 Operations -> Read

Function reads data saved in memory of GPRS module. Exchange of data follows on
port  selected  in  section  “Select  Connection  Type”  (See  below  description  of  option
”Configuration”).  Correct  reading  is  confirmed  with  message  on  a  screen.  Data
downloaded  from device  may  be  saved on file  (see  clause  6.3.3)  and use  for  other
devices. 
To use this function it is necessary to define type and parameters of connection. E.g.
for local connection the following view is displayed:

where:
Connection kind - serial port to which module is connected
Access code- service code of transmitter 

Detailed  description  of  connections  configuration  is  included  in  clause  File  ->
Connections .29
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9.2.2.9 Operations -> Send

This function is analogical to the above one, at the same time it enables data saving
into  EEPROM module.  There  is  also  possibility  to  set  correct  time  into  Active  Track
device. Correct saving is confirmed with message on a screen.

9.2.2.10 Operations -> System events history

„Events history” provides information about last events stored in Active Track device
memory. See chapter Events history

9.2.2.11 Operations -> Device monitor

“Device Monitor” provides real-time information on Active Track device state. See
chapter Device Monitor

9.2.2.12 Operations -> Restore default settings

 If operation “Read” finishes with error message (e.g. if access code is unknown) it is
possible to come back to default settings by selecting “Restore default settings”. On
the  screen  the  will  appear  following  message  “Do  you  want  to  overwrite  current
configuration  with  default  values?”  After  confirming  the  following  window  shall
appear:

61
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This  operation  is  possible  only  with  local  connection.  After  operation  completing
device parameters shall come back to default settings.

9.2.2.13 Help -> About program

Select this function to view additional information about program.
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9.2.3 Programmable parameters

Parameters available in configuration program are divided into three groups: Access,
Transmission, Device parameters, Monitoring, Restrictions, Notifications, Link control
and  Firmware.  Each  of  these  groups  will  be  described  in  detail  in  next  part  of  this
manual.

9.2.3.1 Access

9.2.3.1.1    Parameters

9.2.3.1.1.1  Device mode

Depending of user preferences, a device may operate in 1 out 3 modes (available
from scrolled list):
 GPRS & SMS: GPRS  standard transmission (TCP/IP Protocol), and if any

problems follow with this link it automatically SMS mode will follow.
 SMS: Transmission only in SMS mode, without trial to establish GPRS link.
 GPRS: GPRS  standard transmission (TCP/IP Protocol), and in case of any

problems with this link no transmission will follow.
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9.2.3.1.1.2  GPRS test time

The device sends signal “Test” with determined interval that informs monitoring
station that the device is in operation mode. In this field you can determine how often
this message will be sent (in seconds) .

Note:  
This field will be inactive if device is to operate in SMS mode.  

9.2.3.1.1.3  SMS mode after unsuccessful attempts

Define number of reconnections to server. If during all reconnections fail the device
will go into SMS mode. In this mode Active Track  will try to make connection with
server, according to interval defined  in clause Interval between subsequent
connection attempts .

Note:  
This field will be active if device is to operate in GPRS & SMS mode.  

9.2.3.1.1.4  SMS test time

This  function  is  analogical  to  GPRS.  It  is  activated  when  problems  with  GPRS
transmission follow when the device automatically goes into SMS mode (it relates to
operation mode in SMS). Usually it is undesirable to send text as SMS so often as with
GPRS transmission. Parameter this allow for significant extension of distance between
tests (time in minutes) or completely interlocking of this option.

Note:  
This field will be inactive if device is to operate in GPRS mode.  

9.2.3.1.1.5  Server phone number

If GSM modem is connected to server application (e.g. OSM. 2007) enter in this field
its number. Any SMS will be sent to this number if transmitter has got problems with
GPRS transmission.  If this field is left blank or 0 was entered, the transmitter will be
operating exclusively in GPRS mode. 

Note:  
This field will be inactive if device is to operate in GPRS mode.  

9.2.3.1.1.6  Sends events via SMS immediately

In case of GPRS connection lost device will send SMS reports immediately, even if the
Active Track isn’t in SMS mode yet. 

Note:  
This field will be inactive if device is to operate in GPRS mode. 
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9.2.3.1.2    APN Parameters

Note:  
This group will be inactive if device is to operate in SMS mode.  

9.2.3.1.2.1  APN

Parameter depending on GSM network operator that supplies GPRS (SMS) services. It
provides GSM network access point name. 
It possible to obtain a private access point. In this case a name will be provided  by
GSM network operator.

9.2.3.1.2.2  User ID

When  using  public  APN  ,  user  ID  is  mostly  not  required.  For  private  APN  this
parameter  shall  be obtained from operator  (it  is  impossible  to  be  granted  access  to
GPRS network without it).

9.2.3.1.2.3  User password

When  using  public  APN  ,  user  ID  is  mostly  not  required.  For  private  APN  this
parameter  shall  be obtained from operator  (it  is  impossible  to  be  granted  access  to
GPRS network without it).

Note: 
Private APN provides for higher system security.

9.2.3.1.2.4  DNS1 and DNS2

It determines address of main and backup DNS server (Domain Name System).
If  IP  server  address  has  been  entered  in  form  of  domain  it  is  required  to  provide
minimum one DNS address.

9.2.3.1.3    Primary server parameters

Note:  
This group will be inactive if device is to operate in SMS mode.  

9.2.3.1.3.1  Server address

It  is  address  of  receiver  of  monitoring  system  (OSM.2007)  or  computer  where
“Communication Server” software has been installed , e.g. 89.123.115.8. This address
may be provided in domain name of server, e.g. module.gprs.com. In this case it is
required to provide minimum one address of DNS server.
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9.2.3.1.3.2  Server port

It determines server port that was selected in server for collection of data from
transmitter.

9.2.3.1.3.3  Interval between subsequent connection attempts

Programmable  and  equipped  with  SIM  card  device  will  try  to  make  automatic
connection with server. In this field you define interval (in seconds) after which next
connection will follow if the previous connection failed.

9.2.3.1.3.4  Number of connection attempts

In  this  filed  you  determine  how  many  times  device  will  try  to  make  connection  to
server. If connections fail, Active Track after execution of some connection will  start
procedure  of  connection  to  back  up  server.  This  option  is  active  only  if  we  define
parameters of backup server.

9.2.3.1.3.5  Always try to connect to primary server at first

Mark this check box means, that the device will try in first order to connect to primary
server, without regard on definition of parameters for backup server (in peculiarity of
number of connection attempts).

9.2.3.1.4    Backup server parameters

Note:  
This group will be inactive if device is to operate in SMS mode.  

9.2.3.1.4.1  Server address

It  is  IP  address  of  second  (backup)  receiver  of  monitoring  system  (OSM.2007)  or
computer  where  “Communication  Server”  software  has  been  installed  ,  e.g.
89.130.125.82.  This  address  may  be  provided  in  domain  name  of  server,  e.g.
monitor.gprs.com. In this case it is required to provide minimum one address of DNS
server.   

9.2.3.1.4.2  Server port

It  determines  server  port  that  was  selected  in  server  for  collection  of  data  from
transmitter.

9.2.3.1.4.3  Interval between subsequent connection...

If  device  can  not  connect  to  primary  server  defined  this  after  exhaustion  for  him
number  of  attempts,  it  will  begin  realizing  the  procedure  of  connecting  to  backup
server.  We  in  this  place  define  space  of  time  (in  seconds),  after  which  test  will
connecting renewed if previous finished with failure.
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9.2.3.1.4.4  Number of connection attempts

In  this  field  you  determine  how often  device  will  try  to  make  connection  to  backup
server. If connections fail, Active Track after execution of some connection will  back
to  procedure of connection to primary server. 

9.2.3.1.4.5  Disconnect after time limit

If  you  mark  this  choice  field  the  device  will  disconnect  from  back  up  server  after
passage  of  set  time.  Further  operation  depends  on  defined  parameter  Order  of
connection (See clause Always try to connect... ). If this option is active the device
reconnects  to  the  primary  server.  If  this  option  is  not  active  the  device  firstly
completes connection to backup server procedure and if this fails, the device will try
to connect to the primary server.

9.2.3.1.5    Access

9.2.3.1.5.1  Service code

It provides security against unauthorized access. It is being used during programming
of device and during remote controlling (in TCP/IP or SMS mode). Factory setting is
1111.  During  the  first  starting  of  device  (programming)   it  shall  be  changed.  Code
may consist of up to seven alpha numerical characters.

9.2.3.1.5.2  PIN of SIM card

As  a  device  operates  via  GSM  network,  SIM  card  is  indispensable  and  it  may  be
received  from  phone  operator.  Before  the  first  use  PIN  code  of  SIM  card  shall  be
programmed  for  operation  in  given   transmitter.  PIN  code  is  indispensable  for
automatic system launching. In case of card without PIN code, it is possible to enter
any value e.g. 0000.
If you enter wrong PIN number after inserting card and switching on transmitter,  the
system will not launch and you may be able to use card after entering PUK card only
(with use of any GSM mobile phone).
Factory setting of PIN in Active Track transmitter is 1111.

9.2.3.2 Transmission

For the purpose of maximum security of transmission, data is encrypted with AES key.
This  option  may  be  used  for  GPRS  and  SMS  transmission.  You  may  use  your  own
code (256 bytes – signs 0-9 and A-F) or use default settings.
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9.2.3.3 Device parameters

The  Active  Track  device  allows  for  configuring  the  accelerometer  settings  and  the
microphone  and  loudspeaker  parameters.  It  is  also  possible  to  permit  manual  reset
and turning off of the device by using an appropriate combination of buttons.

9.2.3.3.1    Accelerometer

Thanks to built-in motion sensor it is possible to detect emergencies such as lack of
guard’s motion resulting from assault, or device’s improper position against the axis of
Earth’s  gravitational  field.  Way  to  send  to  the  server  events  generated  by  the
accelerometer  features  of  the  standard  procedure  shall  be  configurable  in  the
Monitoring  tab.  Using  the  link  "Check  monitoring  settings  for  ..."  You  can  quickly
verify the current settings for this procedure.
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9.2.3.3.1.1  ManDown

The ManDown functionality allows for monitoring and signalling motion of the guard
holding  the  device.  The  lack  of  motion  may  result  from  an  assault,  but  also  from
neglecting duties. 

The adjustable parameters are:
 Sensitivity - specifying vibration threshold below which the device determines

its state as lack of motion
 Time  of  immobility  before  the  alarm  -  the  time  following  which  the  device

generates ManDown alarm in case of immobility
 Pre-alarm -  functionality  allowing  the  user  to  get  information  on  detection  of

immobility before the ManDown alarm is generated
 Time  of  immobility  before  the  pre-alarm  generation  -  time  after  which  the

device in a static state signals immobility to the user

Note:
The  method  of  pre-alarming  the  device’s  user  of  the  ManDown  function

activation  (in  other  words:  of  the  approaching  generation  of  ManDown  alarm)  is
described in point Microphone & Speaker .44
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9.2.3.3.1.2  Tilt detection

The device, thanks to the built-in  motion  sensor,  can detect  and signal  its  incorrect
rest position. The functionality may be useful in transport, if a correct position of the
package  is  required  throughout  the  way.  In  such  case  it  is  enough  to  properly
configure the device and firmly attach it in a correct position inside the package. 

The adjustable parameters are:
 Rest position – defined neutral position of the device
 Tilt  – threshold of  deviation (in  degrees) from any of  the device’s  axes, above

which it determines deviation from the rest position
 Tilt time - time following which the device which deviated from the rest position

generates the Tilt alarm
 Pre-alarm  -  functionality  allowing  the  user  to  get  information  on  detection  of

deviation before the Tilt alarm is generated
 Time  of  tilt  before  the  pre-alarm  generation  -  time,  after  which  the  device

signals detected deviation to the user

Note:
The method of pre-alarming the device’s user of the Tilt function activation (in

other  words:  of  the  approaching  generation  of  Tilt  alarm)  is  described  in  point
Microphone & Speaker .

9.2.3.3.2    RFID tags

The RFID tags tab allows for configuring multiple read-outs of RFID points by the
Active Track device.
Tab is active only for device version with built in RFID transponders reader.

44



43Configuration

© 2013 EBS

9.2.3.3.2.1  Maximum time..

Determines the time the device waits to read out the next point from a given session
after the previous read-out.

9.2.3.3.2.2  Maximum number of tags...

Determines the number of RFID TAGs the user can be read in one session.
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9.2.3.3.3    Microphone & Speaker

9.2.3.3.3.1  Microphone sensitivity

Adjustments  made  to  this  parameter  allow  for  setting  the  sensitivity  of  ambient
sounds picked up by  the  microphone of  the  Active  Track  device  during a telephone
conversation.

9.2.3.3.3.2  Speaker volume

Adjustments  made  to  this  parameter  allow  for  specifying  the  sound  volume  of
conversations.

9.2.3.3.3.3  Events signalling

The list allows for specifying sound volume and vibration parameters.
There  are  10  levels  of  sound  volume  for  the  events  listed  below,  and  it  is  also
possible to turn on vibrations for some of them.

 Start RFID loop
 Read RFID confirmation
 Battery discharged
 Incoming voice call
 Incoming SMS message
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 Outgoing call signalling
 Signalling pre-alarm 

9.2.3.3.3.4  Restore defaults

"Restore  defaults"  link  restores  the  default  settings  for  the  microphone  sensitivity,
speaker volume, and way of signaling events.

9.2.3.3.4    Advanced

The Advanced tab allows you to add permission to reset and / or turn off the Active
Track device with the appropriate combinations of buttons.

If  you  select  "Allow  to..."  it  is  possible  to  reset  the  device  or  turn  it  off  using  a
combination of buttons as described in chapter Reset and turn off .

Note: 
Manual reset and turning off the device events are recorded and transmitted to

the  supervising  software  after  turning  the  device  on  and  re-establishment  of
communication link.
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9.2.3.4 GPS parameters

We can define in this tab the main parameters on which generating events LOCATION
UPDATE will depend. The event will be sent to the server, provided that in the 
Monitoring  tab you activate them as reported. Furthermore, if in the additional
information tab for the other events  GPS position is select, along with the event will
be transmitted location information. To generate this event it is necessary to fulfill at
least one of the following conditions.

9.2.3.4.1    Distance

If you select the option "distance greater than" the device will generate an event
LOCATION UPDATE after having moved defined distance in meters from the last
event, no matter which of the conditions generated the event.

9.2.3.4.2    Timeout

If you select an option "Time" the device will generate an event LOCATION UPDATE
counted after a specified time in seconds since the last event, no matter which of the
conditions generated the event.
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9.2.3.4.3    Speed and angle

If you want the device to generate an additional LOCATION UPDATE event when
changing the direction of movement (degrees) when the device is moving we must
also specify a limit on what speed (km / h) above this condition should be checked.

9.2.3.5 Monitoring

9.2.3.5.1    Events

Thanks to this option you may determine which of available signals generated by the
device shall be transmitted to monitoring station.

Using the "Restore defaults" link it is possible to return to the manufacturer's
recommended settings, how to send events to the supervisory software.

Note:
“Configuration changed” event refer to configuration changes made by SMS or

GPRS commands.
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9.2.3.5.1.1  GPRS On / GPRS Off

In this column you define signals that are to be reported to monitoring station with
GPRS  transmission.  There  is  possibility  to  send  information  for  alarms  (e.g.  the
“Panic” button being pushed) as well as in some cases for return to normal state (e.g.
turning off the sabotage switch).
To transmit any signal you should only click it (proper square on your right).
Click on [Clear] button to remove all marked signals.
Click on [Invert] button to change markings to contrary. 

9.2.3.5.1.2  SMS On / SMS Off

In this column you define signals that may be reported at monitoring station with SMS
messages – when there is no connection with server over GPRS. There is possibility to
send information for alarms (e.g. the “Panic” button being pushed) as well as in some
cases for return to normal state (e.g. turning off the sabotage switch).
To transmit any signal you should only click it (proper square on your right).
Click on [Clear] button to remove all marked signals.
Click on [Invert] button to change markings to contrary. 

9.2.3.5.1.3  On priority / Off priority

These columns define which signals  are to be reported to the monitoring station as
first. A priority can be set both for alarms (e.g. the “Panic” button being pushed) as
well  as  in  some  cases  for  return  to  normal  state  (e.g.  turning  off  the  sabotage
switch).

Pressing the [Clear] button deletes all the criteria marked in a given column.

9.2.3.5.2    Additional data

The Additional data functionality allows for defining kinds of additional data which will
be  transmitted  together  with  events  to  monitoring  station  via  GPRS/SMS.  The  data
may  become  valuable  information  about  device's  work  conditions  though  it  may
increase  amount  of  bytes  sent  through  GSM  network.  It  is  possible  to  define  two
separate sets of additional data kinds: for test events (sent periodically according to
setting on Access  tab) and for other events. Put a mark next to the name of data
kind to turn on transmission of this data kind to monitoring station. Empty field means
that this kind of data will be not transmitted.
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The adjustable parameters are:
 Power status - information about connected charger and battery charging
 GSM  status  -  status  about  connection  to  GSM  network,  type  of  connection  to

server (GPRS/SMS), information about ongoing phone calls
 GSM signal level quality - quality of connection to GSM network (CSQ and BER

parameters)
 Movements activity - movements activity read out from accelerometer
 Battery voltage - voltage of battery in millivolt unit
 Location - detailed information about location from GPS module
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9.2.3.6 Restrictions

9.2.3.6.1    Phone numbers...

The user can specify here the phone numbers for incoming calls to be automatically
answered by the Active Track, as well as the number of rings.

 Decline all: No connection possible.
 Allow all: Connection possible from any phone number.
 Allow selected: Connection possible only from the phone numbers on the list.

Up to 8 numbers can be defined.

The edit box becomes active after choosing Allow selected. The subsequent numbers
entered into the field can be added to the table below by clicking the [Add] button.
Placing  the  cursor  in  a  selected  line  containing  the  number  and  clicking  “Delete”
removes the number from the table.

The “Delete all” option removes the content of the whole table.

Note:
Authorization of  incoming call  consists of  comparing the number with that on

the  list.  It  is  possible  to  put  only  a  fragment  of  the  number  on  the  list,  e.g.  1234.
Authorized  then  are  all  numbers  containing  the  sequence,  e.g.  600123456  or  60
1234567.
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9.2.3.6.2    SMS authorized phones

The user can specify the phone number authorized to send configuration SMS to the
Active Track device.

Note:
a) Authorization  of  the  incoming  configuration  SMS  consists  of  comparing  the

number with that in the number field. It is possible to put only a fragment of a
number  in  the  number  field,  e.g.  1234.  Authorized  then  are  all  numbers
containing the sequence, e.g. 600123456 or 601234567.

b) If SMS is sent via the OSM.2007 server’s modem, its phone number (or at least
part  of  it  –  according  to  the  previous  remark)  has  to  be  entered  into  the
aforementioned field.

9.2.3.6.3    Validity period of outgoing SMS messages

User  may  limit  time  for  the  GSM  operator  to  deliver  information  via  SMS  when
recipient is unavailable due to out of GSM signal coverage for example.  Time limit is
defined separately for the following groups of information:

 SMS test to server  
 SMS events sent to server
 Answers to commends

Selection  is  to  be  made  from  scrolled  down  values  by  clicking  on  arrow  besides
selection area.  Allowable  options:  5,  10,15, 30 minutes;  1,2,6, 12 hours;  1,  7  days,
MAX (meaning no specified time).

9.2.3.6.4    SMS limits

User  may  limit  number  of  SMS  sending  by  transmitter.  As  the  main  way  of
transmission should be GPRS this limitation is essential to reduce costs.

Mark field [Turn on SMS limits] to activate access to information groups that
shall subject to limitation:
 SMS test to server  
 SMS event s sent to server
 Answers to commends

Limitation are defined by providing two values:
  SMS maximum number: determines maximum number of sent SMS messages per

time unit (see SMS counter reset). This option protects user against sending 
    too much of SMS messages e.g. in case of failure.      
 
  SMS counter reset: This parameter determines time schedule (in minutes)

according to which counter  of sent  SMS messages will be zeroed
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9.2.3.7 Notifications

9.2.3.7.1    Phone numbers

The user can define here:
 an  EMERGENCY  phone  number  for  outgoing  call,  activated  by  holding  down  the

CallMe button (see chapter Outgoing voice call )

Note: 
This  is  usually  112  or  the  Police  phone  number.  It  is,  however,  possible  to

enter  here  any  phone  number  in  the  format  defined  by  the  GSM  network  operator
whose SIM card is installed in the device.

 SMS -  phone  number,  message  and  checkbox  for  sending  location  for  emergency
SMS activated by holding GPS button

66



53Configuration

© 2013 EBS

9.2.3.7.2    SMS Forward

The device is able to forward received SMS messages according to the specified rules.
This function may be helpful when GSM operator sends messages with account state
to SIM card installed within device. In this window you may provide up to 5 rules.

Each rule contains a pair: part of sender phone number and correct recipient phone
number.  In  some  cases  a  part  of  sender  phone  number  may  be  an  empty  string
which  means  that  any  phone  number  matches  to  the  rule.  All  rules  are  processed
with given order. It means that in some cases one SMS message may be forwarded
to more than one recipients and/or some of them may be forwarded more than once
to the same recipient. The second case may occur when there are at least two rules
with  the  same  recipient  phone  number  and  their  part  of  sender  phone  number
matches with message sender phone number. 

Note: 
It is a user’s responsibility to provide correct rules which will  not create loops

of forwarded SMS messages. 

9.2.3.8 Link control

These  options  enable  automatic  action  of  device  if  communication  with  monitoring
station  was  broken  up.  It  relates  to  situations  when  device  lost  connection  to  GSM
network or if GPRS transmission is impossible.



54 Active Track (beta version)

© 2013 EBS

9.2.3.8.1    GSM

Activate this function (mark [Turn On] field) to get access to parameters determining
action of device if outside GSM network.
Define time limit after which transmitter shall reconnect  to network. Enter time limit
in field [Reset after] and provide this value in minutes.
     
Next  define  action  that  the  device  shall  perform.  Select  action  by  marking  proper
square next action description:
 Modem Reset
 Device Reset

In case of no connection with GSM network the device after recognizing the situation
shall wait during provided time limit and then shall perform programmed actions.

9.2.3.8.2    GPRS

Activate  this  function  to  (mark   [Turn  On]  field)  to  get  access  to  parameters
determining action of device if GPRS connections is lost.
Define time limit after which transmitter shall reconnect  to network. Enter time limit
in field [Reset after] and provide this value in minutes.
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Next  define  action  that  the  device  shall  perform.  Select  action  by  marking  proper
square next action description:
 Modem Reset
 Device Reset

In case of no connection with GPRS network the device after recognizing the situation
shall wait during provided time limit and then shall perform programmed actions.

9.2.3.9 Firmware

The device is equipped with built in bootloader that allow for updating and change of
firmware.  During  programming  all  information  is  displayed  in  respect  of  carried  out
operation. 

Follow the procedure:
a) Launch configuration program
b) Open “Firmware” option of configuration wizard
c) Open file with new firmware (click [Open] button to locate where file is).
d) Select file transmission mode: local or remote.

Note: 
Procedure of  assigning firmware  to  a  device  is  analogous   to  programming a
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device. For procedure refer to chapter Device programming .

e) Click [Start] button to start software exchange.
f) Loading course is displayed on special window.
g) Close the window after completed saving

From this time on the device will work under control of new firmware.  

Note: 
The  above  procedure  shall  be  carry  out  with  due  care  to  avoid

improper device operation.

9.2.4 Device programming

Programming of device is possible with “GPRS transmitters configurator” configuration
program  described  in  chapter  Configuration  program .  To  program  the  device
establish connection with a device.
Depending on connection mode there are two ways for programming.

9.2.4.1 Programming adapter and cable

In  order  to  gain  access  to  device's  programming  functions  via  RS232  port  special
programming adapter (AGP3) and cable (LX-PROG or LX-DATA) is necessary. Adapter
is equipped with two connectors: PROG and MODEM. The first  one is  used for  local
programming,  controlling device's  state  (Device Monitor)  and reading device's  event
history. The second connector may be used for GSM modem work auditing.

Below is a summary of AGP3 adapter and cables application:
 

AGP3 LX-PROG LX-DATA

Device programming ● ● ○

Firmware update ● ● ○

Events history ● ● ○

Device Monitor ● ○ ●

9.2.4.2 Local programming

To program a device locally follow the procedure:

a) Turn  the  device  upside  down,  open  lid  by  unscrewing  bolts  and  take  it  off.
Remove battery from cavity (don't disconnect it!) and fasten AGP3 adapter in a
socket located near SIM card holder.

b) Connect  PROG  joint  (on  AGP3  adapter)  with  COM  computer  port  by  way  of
service wire, defined in option Connections -> RS-232.

c) After connection and detection of programming wire a module shall signal this
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with LED diodes: an orange one shall flash and red one shall flicker.
d) Launch  software  and  define  device  options  (description  is  in  chapter

Programmable parameters ). Provide right PIN code for SIM card.
e) Save  settings  into  memory  of  device.  Saving  course  is  displayed  in  special

window.

f) After saving insert SIM card, disassembly AGP3 adapter and service wire. 
g) Put  battery  into  cavity,  lay  down  wires  and  close  lid  by  screwing  bolts

according to chapter SIM card and battery installation .
h) The device is ready to transmit data.

9.2.4.3 Remote programming

Remote programming  of device is possible if:
 user uses GPRS transmitters configurator and GSM modem connected to PC 
 user uses OSM.2007 monitoring system receiver. 

In  first  case  remote  programming  is  possible  on  CSD  channel  and  its  procedure  is
analogous  to local  programming, remembering that “Modem GSM” shall  be  selected
from connection options (See chapter CSD linking ). 

Note: 
Remote configuration with use of CSD canal is possible only if transmission of

CSD data is active both for SIM card inserted in the device, and for SIM card installed
in GSM modem. 

In second case according to description in  chapter  GPRS linking ,  it  is  required  to
define remote link on grounds of  OSM.2007 parameters. As OSM.2007 collects  (and
transmits) information exclusively from devices saved in data base, the first operation
during remote programming is proper registration of  the device. This procedure has
been described in OSM.2007 Operation Manual.
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9.2.4.3.1    The first programming of device

As the device does not have defined access parameters in respect of  GPRS network
and  OSM.2007,  programming  shall  be  begun  with  providing  parameters  defined  in
chapter  Programmable  parameters .  After  providing  these  parameters  register  the
device in OSM.2007 data base (see OSM.2007 manual).
Before  remote  programming  user  shall  check  that  the  device  is  furnished  with  SIM
card (with reservations provided in chapter PIN code ) and is  connected to power
supply. User shall know serial number of device and phone number for SIM card.

Follow the procedure:

a) With  the  use  of  OSM.2007  console  position  cursor  on  proper  device  in  
“Devices”  tab   (make  sure  that  OSM.2007  has  proper  device's  access
code entered!).

b) Click “Config.” option and then select “Set Configuration” function to display lit
of parameters.

c) Enter server address, server port and APN. Click OK and system shall send to
device provided parameters (SMS).

d) Wait till device addresses server (in “Devices” tab it will be marked with green
colour).

e) Launch  software  and  define  options  of  device  (description  is  provided  in
chapter Programmable parameters ).

f) Select  “Send”  to  display  a  new window and  select  remote  connection  (GPRS
tab). Save settings in memory of device. Saving course is displayed on special
window. 

g) After saving completion close Configuration Wizard.
h) The device is ready to transmit data.

9.2.4.3.2    Reprogramming of device

As  the  device   has  defined  access  parameters  in  respect  of  GPRS  network  and
OSM.2007, it is possible to program device at any time.
If device is installed in secured object and is furnished with SIM card and connected
to power supply follow the procedure:

a) Launch  configuration  wizard  and  define  options  of  device  (description  is
provided in chapter Programmable parameters ).

b) Select  “Send”  to  display  a  new window and  select  remote  connection  (GPRS
tab). Save settings in memory of device. Saving course is displayed in special
window. 
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c) After saving completion close Configuration Wizard
d) The device is ready to transmit data according to new settings.
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9.2.5 Device Monitor

“Device Monitor” provides real-time information on Active Track device state. To use
this  function  Active  Track  must  be  connected  to  PC  computer  with  LX-DATA  cable
(using  DEBUG  plug).  Correct  RS232  port  must  be  chosen  in  “Port”  field.  “Device
monitor” provides following information:
 Battery power indication 
 Charger and charging indicators
 GSM network signal level indication
 Bit-Error-Rate level measuring
 Inputs and motion sensor state monitoring
 Ongoing voice and data call indicators
 Type or serial number of device
 Firmware and hardware revision
 Device time

These parameters are also shown in LOG window in text style. All data can be saved
to file.
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9.2.6 Events history

„Events  history”  provides  information  about  last  events  stored  in  Active  Track
device memory. Active Track is able to save 192kB of  data, which is about 8000
events.  It  is  possible  to  read  the  history  of  both  using  a  GPRS  connection  and
RS232. In the second case data can be send to PC only  via LX-PROG cable  (the
white  one).  Correct  RS232  port  or  GPRS  connection  must  be  chosen  in  “Choose
connection  kind”  field.  After  providing  Service  code  and  clicking  “Open”  button
events data will be downloaded from Active Track memory. After properly reading
access to features such as the "Filtering" and "Charts" becomes possible. Both of
them may be used to quickly diagnose the device.
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10 Controlling commands

Active Track can receive control messages through SMS messages or GPRS link
(e.g. by using Console of monitoring receiver OSM.2007). These messages can enable
additional  functions  of  device  or  request  additional  information  about  device
condition.  

BEEP=f,d,n,v

Generates acoustic signal with f frequency, d signal length (in multiply of
100ms), n repeats and v volume.

DISC
Disconnects device from server.

FLUSH=x
Clears the FIFO queue, where x means that the queues to be cleaned: 
0 - the queue of outstanding events to be sent to the server 
1 - events history (see Events history )
Example: FLUSH=0

CONNECT
Force immediately attempt of connection to server. 

KILL 
Sending this command remotely resets the device.  

CMD = AT_command
Sending it makes the device modem follow this command and return report of
action result. Particular commands has been blocked due to safety reasons and
would be reported as <blacklisted> if received. 
 
Example:
CMD=AT+CSQ (enables remote reading of the device GSM signal level).

VER 
Sending this command makes the device send software version as a reply.  

DESC 
Sending this command downloads the device description in Active Track v.VER

GETCFG 
Sending this command returns current device configuration. Parameters are
returned in following style: SERVER:PORT APN UN PW SMS TPERIOD
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GET=[parameter names, separated by commas]
Sending this command returns current value of given parameter (e.g.
GET=SERVER,APN will return for example: 89.172.87.135 erainternet).

LOCATION
Sending this command makes the device send GPS location as a reply. 

11 Operation rules

ACTIVE TRACK is an intgrated, wireless device that allows location of  the person or
property.  Unit  has  built  in  GPS  receiver  and  a  quad  band  GSM/GPRS  module  with
phone function for two way communication. 
This functional advanced device can be applied indoor and outdoor because of A-GPS
service, that supports GPS signal from satellites by GSM/GPRS.
In an emergency situation you may send from the unit two types of signals: "Call" or
"Attack".
Optional, device might be equipped built in RFID transponders reader. 

RFID transponder read-out

Read-out RFID transponders manual applies only device with built in RFID
transponders reader.

If you wish to read ID-Tag, label or RFID card, press “Read-out” button and
within 15 seconds approach it with reading area (see Functions review ).  In case of
no read-out, the device returns to normal work mode after that time. 

If option of several RFID tags read-out in one session is enabled (see RFID in
chapters  Remote  configuration  and  RFID  tags )  procedure  is  following:  after
push of "Read-out" button first tag must be read in 15 seconds time. Next tags must
be  read  in  time  period  not  longer  than  set  in  RFID  parameter.  The  steps  can  be
repeated until last RFID read-out.
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For more information about expecting time for transponder and confirmation of
correct read-out, go to Indicating work mode .

Sending „Panic” command

In  emergency,  you  may  send  “Panic”  command  to  monitoring  station  by
pressing “Panic” button. 

Sending „Call me” command

In emergency, you may send “Call me” command to monitoring station. It
means you expect operator to call you back. 

Voice connection (incoming)

The device allows automatic answering of calls. Operator may call the device at
any time, particularly after “Call me” command. After phoning signal – length of which
was  previously  set  up  –  voice  connection  is  established.  It  is  exactly  the  same  as
mobile  phone  conversation.  The  connection  is  automatically  ended  when  operator
hangs  up.  The  user  is  unable  to  end  it  first.  All  other  functions  are  blocked  for  the
time of connection.

During conversation, talk to microphone and hold loudspeaker close to ear. For
more information on where these parts are located, go to Functions review .
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Outgoing voice call

Active Track device is able to establish voice call  with programmed telephone
number (parameter:  EMERGENCY).  After  pushing and holding down "Call  me"/"Help
me" button Active Track will establish a voice call - just like in cellular phones. To end
a voice  call  it  is  necessary  to  push  any  button  (or  wait  for  end  of  call  initialized  by
another side). When making a voice call all functions of Active Track are disabled.

During conversation, talk to microphone and hold loudspeaker close to ear. For
more information on where these parts are located, go to Functions review . 

Checking GSM range

You may check power of  your GSM Provider signal  at any time by pressing “
Checkpoint” until yellow LED light and then “Call” buttons and power of signal will be
displayed. For more information, go to Indicating work mode .

13
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Reset and turn off

The Active Track device can be reset or turned off, provided that is configured
to allow this type of activity (see chapter Advanced ). The following describes how
to reset / turn off the device

 

Action
Pressing both Panic and
Checkpoint buttons by 7

seconds
Beep

Pressing Panic or Checkpoint
button

Description

RESET

TURN OFF

 RESET - press and hold for about 7 seconds simultaneously  the two buttons:
Panic  and  Checkpoint.  After  this  period,  and  after  hearing  the  audible  signal
stop pressing buttons. The Panic button should then begin to flash rapidly (this
means that the  resetting is permitted) for an additional 7 seconds. During this
period, only re-press the same Panic button to reset the device.

 TURN  OFF  -  press  and  hold  for  about  7  seconds  simultaneously  the  two
buttons: Panic and Checkpoint. After this period, and after hearing the audible
signal stop pressing buttons. The Checkpoint button should then begin to flash
rapidly  (this  means  that  the   turning  off  is  permitted)  for  an  additional  7
seconds. During this period, only re-press the same Checkpoint button to turn
off the device.

Accelerometer operation

The motion sensor built-in into the device can detect:
 lack of motion of the person holding the device,
 incorrect position of the device against the Earth’s gravitational field,
 the device striking too strongly against a hard surface.

It is also possible to determine one’s own position and its change in relation to
the Earth’s gravitational field. This applies to motion both in straight line and along a
curved  trajectory.  In  one  specific  case,  however,  the  change  in  position  cannot  be
determined  –  when  the  motion  is  taking  place  exactly  and  only  around  the  axis
parallel to the axis of the gravitational field crossing the sensor. The examples below
present situations where it is not possible to detect such rotation (in order to keep the
pictures simple the axes of the device cross in its geometrical centre, and not in the

45
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location of the sensor). 

Note:
It should be kept in mind that almost any change in location, according to the

laws of physics, is a resultant of many forces. In most cases the rotation is not ideally
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parallel to the axis of gravitational field going exactly through the middle of the small
sensor  placed  asymmetrically  in  the  device.  Consequently,  it  can  be  assumed
that the device can detect motion (or lack thereof) of any type. 

12 Indicating work mode

Each  work  mode  currently  in  use  will  be  signalled  with  adequate  flashing
combination of buttons.

Registration at GSM network

Registering is being signalled with slow flashing of “Checkpoint” button.
                                 

During normal work, the device signals correct operation with short flashes of
“Checkpoint” button every 5 seconds. 

GSM range

Once GSM range checking is started, the device displays GSM signal power (for
more information, go to Checking GSM range ). Additionally, after each display work
mode is shown (GPRS or GSM). The display consists of flashes of “Checkpoint” button
in amount proportional to GSM signal power. Whole sequence is being repeated three
times after which the device returns to normal work mode. 

Example of single sequence:  4/8 reach, GPRS mode:

Example of single sequence: 3/8 reach, SMS mode:
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GPS positioning

GPS positioning is being signalled with slow flashing of  „GPS” button.

After get the valid GPS fix, during normal work of GPS, the device signals
correct operation with short flashes of “GPS” button every 5 seconds. 

RFID transponder read-out

Version of Active Track with built in RFID transponders reader is able to read-out
RFID tags in two ways (like described in chapter Remote configuration ): single and
repeated read-out. Signaling way is following:

Read-out mode: single (RFID=0,0)
After  starting  of  RFID  transponder  (see:  RFID  transponder  read-out )  device

waits for bringing near to the RFID tag. Wait time (15 seconds) is signalized by light
on "Read-out" button. Device confirms RFID read-out by double, short acoustic signal
and switching "Read-out" button light off and on. Next transmission begins.
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Read-out mode: repeated (RFID=5,5)
After  starting  of  RFID  transponder  (see:  RFID  transponder  read-out )  device

waits for bringing near to the RFID tag. Wait time (15 seconds) is signalized by light
on "Read-out" button. Device confirms RFID read-out by double, short acoustic signal
and  switching  "Read-out"  button  light  off  and  on.  Next,  device  waits  5  seconds  for
next RFID read-out. Each read-out is confirmed in the same way. Data is transmitted
after 5 read-outs (FIFO rule)

Data transmission

Data transmission is being signalled with quick flashing of “Checkpoint”
button. 

Data transmission

Making out-going voice calls

Procedure of making out-going voice calls begins with pushing and holding
"Call me" button. "Checkpoint" LED starts to blink (like when transmitting data). After
2-3 seconds acoustic signal is generated. Holding down the button will generate next
acoustic signal (after 2 seconds). Then "Checkpoint" button light will start to blink
with frequency of 1Hz.

Battery low

When battery  low,  it  is  being signalled  with  2-hour  advance  before  switching
off.  “Panic”  button flashes  every  5  seconds  and  there  are  two  longer  sound  signals
every minute. It is recommended to charge the device at once (for more information,
go to Battery charging ).
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Battery charging

Once in charger, the device starts charging automatically. It is being signalled
with flashing of “Call me” button. 

Warning: 
When connected device had completely empty battery blue LED may become darker
for about 15 minutes.

Battery full

When battery is fully charged “Call me” button lights up.

Battery full

System general error

When error is detected, it is  being signalled with alternate flashing of  “Panic”
and “Call me” buttons.  Contact your service immediately. 
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Note: 
similar signaling may be visible after powering-up device. It may last for 3

minutes and it does not mean failure.

SIM card error

In case of problems with the SIM card the device indicates this fact by blinking
of "Panic" and "Checkpoint" buttons (the "Panic" button will blink slightly less often
and the time of illumination is shorter compared to the blinking of "Checkpoint"
button). In such situation you must verify the SIM card mounting and / or its correct
operation with a mobile phone.
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13 Cooperation with monitoring system

Proper using of all functions of Active Track require monitoring system, which will be
able to sent, receive and interpret all messages from Active Track. Main device in that
system is receiver (communication server) and Analyzer software. Analyzer software
interprets data from Active Track device, store them and visualize them in proper and
readable way.

Active Track will sent to the server following information:

GPS
Information about actual device position

EMERGENCY
Pushing of Emergency button will cause sending suitable message to the
receiver.

Note: 
Information about pushing Emergency button cannot be send more frequently
than once for minute. When button is pushed more frequently, message about
second push will not be send (LED will light-up signalizing pushing of button).

CALL ME
          Pushing "Call me"" button will sent proper message.

Note: 
Information about pushing “Call me” button cannot be send more frequently than
once for minute. When button is pushed more frequently, message about second
push will not be send (LED will light-up signalizing pushing of button).

RFID
Note: 
Applies only device version with built in RFID transponders reader.

After RFID read-out , Active Track device will send unique ID of RFID tag. In
case of repeated read-out mode data will by sent after last RFID read-out (or
after defined time)

SABOTAGE
In case of sabotage (attempt to open the casing) device will send proper
message.

SHOCK
Any instance of the device striking too strongly against a hard surface is
detected and sent to the monitoring station.
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MANDOWN
When the emergency consisting immobility of the person holding the device is
detected, the corresponding signal is transmitted to the monitoring system.

TILT
Detection of incorrect position of the device results in transmission of a signal
informing the monitoring system operator of this fact.

TEST
For proper control of data transmission channel device is sending to the
monitoring receiver  periodic signal. That signal ensure that device is working,
is connected to GSM network (GPRS, SMS) and is connected to the
communication server.

BATTERY DISCHARGED
When battery is discharged (read chapter 6. for information about signaling
discharged battery), Active Track will sent proper message to the server.

BATTERY CHARGING STARTS
When device is charged in appropriate charger, Active Track will sent proper
message to the server.

BATTERY FULLY CHARGED
When battery is fully charged, proper message will be sent to the receiver.

BATTERY FULLY DISCHARGED
When the battery is discharged to the extent not allowing for its further
operation, the device saves this information into memory and turns off.
Appropriate information is sent to the monitoring system operator after the
correct power supply is restored.

RESET
The device was manually reset using an appropriate combination of buttons. A
report is transmitted after re-establishment of communication link.

POWER OFF
The device was manually turned off using an appropriate combination of
buttons. A report is transmitted after you turn the device on (using any of the
buttons) and re-establishment of communication link.

CONFIGURATION CHANGE
Each change of configuration (e.g. SMS message with new settings) will end
with sending proper message to the receiver.

SMS LIMIT
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Reaching the limit of SMS messages sent by the device is reported to the
monitoring station in order to allow for subsequent analysis of the system
operation.

CLIP
Any incoming call from a number not appearing on the list of authorized
numbers results in connection refusal and transmission of the corresponding
signal to the monitoring system operator.   

INCOMING/OUTGOING CALL
Information on outgoing and incoming calls is sent as a corresponding signal to
the monitoring system operator. The exact way of the outgoing call signalling
is described below. 

WATCHDOG
Following a defined time of GSM/GPRS connectivity disruption the device
performs a specified action (e.g. modem reset) and saves appropriate
information into memory. When the connectivity is re-established, the
information is sent to the monitoring station in order to allow for subsequent
analysis of the system operation. 

Note: 
If there is no connection between Active Track device and server, Active Track

will  store  events  into  its  internal  memory  (up  to  5000).  When  connection  is
established,  Active  Track  will  sent  all  events  stored  in  memory  in  FIFO  order  with
priorities defined in Monitoring . 

Note: 
Outgoing voice call, depending on its course is indicated as follows: 
a) When a number  is  dialled  and the  recipient  rejects  the  call  -  generate  a

couple  of  events  "OUTGOING_VOICE_CALL_BEGIN"  and
"OUTGOING_VOICE_CALL_END"  with  the  same  or  similar  time  and
modem answer is added to the events history. 

b) When the connection can not be achieved due to network problems - as in
a) point. 

c) When the call is successful - the "OUTGOING_VOICE_CALL_BEGIN" event
is  generated   when  the  recipient  answers  the  call,  and  the
"OUTGOING_VOICE_CALL_END"  event  when  the  connection  is
terminated.  In  addition,  if  the  recipient  ends  the  call  modem  answer  is
added to the events history. 

d) When the user ends the call before it will be picked up by the recipient -
generate  a  couple  of  events  "OUTGOING_VOICE_CALL_BEGIN"  and
"OUTGOING_VOICE_CALL_END" without an entry in the history of events
with the modem answer.
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14 Information about batteries

Battery charging and discharging

The device is powered by rechargeable battery.

Note:
New  battery  is  not  fully  charged  and  requires  charging.  Full  efficiency  is

reached after 2 or 3 chargings and dischargings!

Battery  may  be  charged  and  discharged  hundreds  of  times  but  eventually  it
would need replacement. If work time becomes noticeably shorter than usual, battery
should be replaced with new one. 

Use  only  batteries  and  charger  approved  by  The  Manufacturer.  Follow  the
same advice as for  battery  chargers.  If  charger is  not in  use,  plug it  off.  For  safety
reasons, do not charge longer than for 7-day time. If full battery is not in use, it will
discharge with time. 

Extreme temperatures has got adverse impact on  charging.  Leaving batteries
in hot or cold places (i.e. in vehicle in summer or winter time) would shorten lifespan
and  lower  its  capacity.  Try  to  keep  battery  between  15°C  –  25°C.  The  device  with
excessively hot or  cold battery  may not  work  for  some time,  even if  battery  is  fully
charged.  In  the  sub-zero  temperatures  battery  efficiency  is  especially  low.  Never
dispose of battery into fire!

Battery should be used only according to its specified purpose. Do not ever use
inefficient battery or charger. Avoid short circuit of battery polarities, even though it
has got system protecting against short circuit. 

Used batteries should be recycled or disposed of according to local regulations.
Do not throw batteries to public or home dust bins. 
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15 Operation and maintenance

The device is  a hi-tech Product  and requires  proper  handling.  Following instructions
below would keep guarantee valid and ensure proper operation for years. 

 Keep the device, its parts and accessories out of reach of children.
 Do not expose the device to excessive dirt, dust or water contact.  
 Do  not  keep  the  appliance  expose  to  high  temperature,  which  shortens  the

lifespan of batteries and electronic modules.
 Do  not  store  the  device  in  temperatures  lower  than  minimum  working

temperature due to battery lifespan.
 Do not open the device. Unprofessional interference may cause damage.
 Do  not  throw,  drop  or  hit  the  device  without  reason.  Mishandling  may  cause

damage to electronic parts.  
 Do not use any solvents or strong detergents chemicals for clearing.  
 Do  not  paint  or  varnish  the  device  as  it  may  break  down  buttons  or  stick

connectors. 

The above instructions concern the device, its battery, charger and other accessories.
In case of malfunction of any element, contact your service to obtain help in solving
problem or have it fixed.

16 Exemplary implementation

 Supervising work of guards, caretakers etc. 
 Supervising work of delivery men, e.g. emptying letter boxes.
 Recording presence of service representatives/ technicians in specified places and

its lasting time.
 Supervising work of walk or vehicle patrols 
 Supervising drivers work or carried loads 
 Reporting occurring the events that require supervising 



79Exemplary implementation

© 2013 EBS

17 Technical parameters

GSM module

u-blox Leon G-100 (850/900/1800/1900 MHz)

GPS module

Channels 50 channel u-blox 6 engine

A-GPS online/offline support YES

Position accuracy < 2.5 m

TTFF hot start acquisition time < 1 s average

TTFF cold start acquisition time < 27 s average

Electrical characteristics

Power supply 5V/1A

Power socket standarized Micro USB type B plug

Battery Li-Polymer, 2400 mAh

Battery working time (GPS position and test every 60s) 24 hours

Physical characteristics

Dimensions (HxWxT) 121x60x30 mm

Casing durability The waterproof and shock resistant housing

Weight 175g (device); 30g (charger)

Motion sensor

3-axis motion sensor (accelerometer)

RFID reader (optional)

Reader type Proximity RFID

RFID reader frequency 125kHz

RFID read-out distance 3-4cm (depends on transponder type)

Interfaces & general features

Internal speaker and microphone

4 Buttons for easy operating

Ambient operating temperature: -20 °C to +60 °C

Data transmission via GPRS (TCP, IP), SMS to OSM.2007

Voice call

Silent call

Remote administration & firmware update

Configuration

Local: PC through RS232 link (LX cable and AGP3 programmer
required)

Remote: via GPRS, SMS, CSD

Alarm events buffer size 1000

Quantity of system events stored in history 2000


	FOR YOUR OWN SAFETY
	All about accessories
	Device versions
	General information
	PIN code

	Transmission safety
	Data coding

	Functions review
	GPS module
	RFID transponders reader
	Controlling buttons
	Work mode indicator
	Loudspeaker and microphone
	Accelerometer
	Clock
	Memory
	GPRS service (General Packet Radio Service)
	Before using GPRS technology
	GPRS service charges

	A few words about the device
	Functional elements

	First steps
	SIM card and battery installation
	Battery charging
	Sleep mode

	Configuration
	Remote configuration
	Configuration program
	Computer - requirements
	Program functions
	File -> New
	File -> Open
	File -> Save
	File - > Language
	File -> Connections
	Local connection
	Remote connection
	GPRS linking
	CSD linking


	File -> Archiving
	File -> Exit
	Operations -> Read
	Operations -> Send
	Operations -> System events history
	Operations -> Device monitor
	Operations -> Restore default settings
	Help -> About program

	Programmable parameters
	Access
	Parameters
	Device mode
	GPRS test time
	SMS mode after unsuccessful attempts
	SMS test time
	Server phone number
	Sends events via SMS immediately

	APN Parameters
	APN
	User ID
	User password
	DNS1 and DNS2

	Primary server parameters
	Server address
	Server port
	Interval between subsequent connection attempts
	Number of connection attempts
	Always try to connect to primary server at first

	Backup server parameters
	Server address
	Server port
	Interval between subsequent connection...
	Number of connection attempts
	Disconnect after time limit

	Access
	Service code
	PIN of SIM card


	Transmission
	Device parameters
	Accelerometer
	ManDown
	Tilt detection

	RFID tags
	Maximum time..
	Maximum number of tags...

	Microphone & Speaker
	Microphone sensitivity
	Speaker volume
	Events signalling
	Restore defaults

	Advanced

	GPS parameters
	Distance
	Timeout
	Speed and angle

	Monitoring
	Events
	GPRS On / GPRS Off
	SMS On / SMS Off
	On priority / Off priority

	Additional data

	Restrictions
	Phone numbers...
	SMS authorized phones
	Validity period of outgoing SMS messages
	SMS limits

	Notifications
	Phone numbers
	SMS Forward

	Link control
	GSM
	GPRS

	Firmware

	Device programming
	Programming adapter and cable
	Local programming
	Remote programming
	The first programming of device
	Reprogramming of device


	Device Monitor
	Events history


	Controlling commands
	Operation rules
	RFID transponder read-out
	Sending „Panic” command
	Sending „Call me” command
	Voice connection (incoming)
	Outgoing voice call
	Checking GSM range
	Reset and turn off
	Accelerometer operation

	Indicating work mode
	Registration at GSM network
	GSM range
	GPS positioning
	RFID transponder read-out
	Data transmission
	Making out-going voice calls
	Battery low
	Battery charging
	Battery full
	System general error
	SIM card error

	Cooperation with monitoring system
	Information about batteries
	Battery charging and discharging

	Operation and maintenance
	Exemplary implementation
	Technical parameters

